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Agile Business Suite Interfaces

Practical Examples
Nigel.Tunnicliffe@Unisys.com




Agenda

Review potential interface requirements
Examine both inbound and outbound options

Show customer solutions

)
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The good old days




Today

Many more channels

Agile Business Suite applications are g g g
both the consumer and provider of &0 § J
services

AB Suite
Application

Application Application
Server Server
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Examples




Leveraging the .Net Framework

Business Problem Solution
° Invoke .Net Framework from Agile * Use Business Integrator and the HUB
Business Suite mechanism

= E.g. Encrypt data * Standard feature of Agile Business

Suite

)
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Business Integrator Architecture

ClearPath MCP Windows

Ispecs

ClearPath
Agile Business
Suite Application P

NET

uB

I - Ispecs Assembly

L] N
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Development Process - Define the Ispec

I File Action ‘Wiew Window Help |;{_i|£|
l« =+ a@E XD @ 8 +XEvYVenrx
I.D Cansole Roat ProxyTest

E@ Enterprise Application External T I EHiTine I Length I Decimals

= B Local
S = SECRET Alph S0 1]
Component Specificatio P

: L ProxyTest
: - 88 Deployed Components
¥ Enterprise Application External

f=)
=

TEXT Alpha 1n 0

fi] m y ] 1< m EY

L] N
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Development Process - Create the Script

UNISYS |

Securing Your
Tomorrows®

' External Components - [Console Root\Enterprise Application External Components\Local\Component Specificati.

os

I File  Action Wiew ‘Window Help | = !Elﬂ
||1--u &|m| X =2 B o+
].[:I Console Root | ProxyTest
@ Enterprise Application External
=l ﬂ Local il E — Press Bun button b start the test
Component Specificatiol
- ProxyTest Item Mame I Yalue I Edit Tvpe I Length I Decimals|# |
-8 Deployed Components SECRET . Alpha 2] ]
# ¥ Enterprise Application Externalt TEXT : Alpha 10 0 A
ISPEC, OwinHost O GEME-TUNMNICLIF Alpha 17 1] 3
ISPEC. Shorthame r TEST Alpha 5 i] |
ISPEC. Trans. CallerEny . Alpha 10 a
ISPEC. Trans.CallerHost - Alpha 17 i}
ISPEC. Trans.Callersys,.. - Alpha 10 i]
ISPEC. Trans.Language . Alpha 10 1] L
___TSPF(C. Trans.OrininFna - Alnha in n t]
2l i e

'Create a reference to the Estermal Component Proxy object
Set Proxy = Createl bject"E stemalComponents. Proxy']

'Encrypt the text
ISPELC.Fields["SECRET"") = Proxy. Encrypt| SPEC. Fields["TEXT"])

B I 2]
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Development Proces

s - Test the Script

s - [Console Root\Enter onent Specificati... (= |2/[23
File  Action Wiew ‘Window Help |=!_i|£|
= = E@E X 2B+ AETYe R
D Console Root | ProxyTest
= @ Enterprise Application External -
- B3 Local il E .\!) Exrecution succeeded
Component Specification
- 2 ProwyTest Tkem Marne | value | Edit Type | Length ||
-8 Deployed Components SECRET ' HUPRRObZdoUZhuyfeGESmy== alpha 50
[+ # Enterprise Application External i e ” T i ja A
1SPEC. OwrHost 3 GBMK-TUNNICLIF alpha 3
ISPEC. ShortMame O TEST Alpha k|
ISPEC. Trans. CallerEny Alpha 10
ISPEC. Trans. CallerHost Alpha 17
ISPEC. Trans.CallerSys. .. Alpha ia
ISPEC. Trans.Language Alpha 10 L
TSPFC. Trans. OrininF sy Alnha mn B]

< ] {111

< i |

'Create a reference to the Extermal Compaonent Proxy object
Set Prosy = CreateObject]" ExtermalCampaonents. Proxy')

'Encrypt the text
ISPEC.Fields["SECRET") = Proxy. Encrypt| SPEC. Fields["TEXT")

L] .
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Leveraging the .Net Framework

Invoke .Net Framework from Agile Write an external library in C# or
Business Suite on Windows VB.Net
Update custom table in application Pass Agile Business Suite application
database variables as parameters
Get report status Perform any function that can be
Create fixed width file implemented in .Net
Parse XML
Many more

°
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Invoking External Services

Business Problem Solution
* Invoke an external web service from * Use ClearPath Application Integration
Agile Business Suite Services (AlIS) to autogenerate proxy

interface code

* Use ePortal to generate a proxy to
invoke the service

°
UNISYS | ?Sﬁ#;‘!:%v‘ﬂ"”’ © 2020 Unisys Corporation. All rights reserved. | 12



ClearPath

Solution - ClearPath Microservices - Outbound using AlS

Auto
Generated
REST API

Windows
based external
system

ClearPath MCP

—— N ~ APl Gateway

NET

Assembly
DI AlS Inbound

ClearPath

Agile Business
Suite Application

A

MCP Library
AlS Proxy
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On-Line Banking System

Expose Ispec functionality as Micro-
Services

Short development timescales

Small development team

UNISYS | fecrg o

Use ClearPath ePortal to automatically
create RESTful services from Ispec
definitions

Automatic scaling and management
using ePortal

Industry standard API testing tools

© 2020 Unisys Corporation. All rights reserved. | 14



Agile Business Suite and
Microservices

Inbound REST Services

Windows (ePortal Cluster)

Inbound

Call Egterprlse N ClearPath > Agile Business
i > ervice ePortal Suit
“—— Bus RESTful Servi ) cat
ul Services Application
(Web API)
P >
Direct Calls

°
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Sample Microservice

Simple Ispec Service
F Te Chenti v - i

Microservice

-
%) WCF Test Client

File

Tools

Help.

<

=] My Service Projects
- &1 hitp-//localhost 24140/Service sve

57 ServiceCortract (WS HttpBinding_Servi

2

=4 Carnect)

4 Disconnect

4 SendMessage()
4 Send_Selectlspec()
-4 Sendoonnect_Basic()
-4 SendCustomerAndProduct)

4 SendGetAlCiertFesponse()

“ SendGetAlClients)

“@ SendGetCustomer{)
-4 SendGetCustomerAndProduct )
=% SendGetProduct()

4 SendGetProductSales()

4 SendProduct Detais)

4 SendProduct Sales()
-4 Sendsamplemcp_CASH{)
=4 Sendsamplemcp_CING()

4 Sendsamplemep_CNOTE(

4 Sendsamplemep_CUST()
4 Sendsamplemcp_DOX(
=4 Sendsamplemcp_INGDS()
4 Sendsamplemcp_MENU{)

% Sendsamplemep_NINGD

4 Sendsamplemcp_PROD()
4 Sendsamplemcp_REFT()
4 Sendsamplemcp_RMENU(

4 Sendsamplemcp_SALE])
& Sendsamplemep_SERCH()
4 Sendsamplemcp_SINQ)
4 Sendsamplemcp_SREF()
& Sendsamplemap_VEND{)
-4 Sendsamplemep_VPROD(

Corfig File

.

Sendsamplemep_CUST

Request
Name Vaiue Type
ACTMTH o System Int32 s
ACTION ) System.Sting F
POSTADDI i) System.String
CUSTOMER xrz System String
POSTADDZ () System Stiing
NAM fruil) System.String E
POSTADD3 ) System Sting
CREDLIMIT [} System Int32
CUST_TYPE i) System String
DELADD1 ful) System.String B
DELADD2 ) System String
DELADD3 ) System String
CAl FSRFR rally Cuatam Shina ot
I = gananonpy
Name Value Type
4 SAMPLEMCPDS Client samplemog «
ACTION System, String
ACTMTH 1208 System Int32 L
CREDLIMIT System Int32 3
CUSTIMAGE “@\daiiimages\\XYZ bmp@DI System String (4
CUSTOMER "XYZ" System String
CUST_TYPE System String
DELADD1 System String
DELADD2 System String
DELADD3 System Sting
MAINT NG System. String
Messagelist_ System Sting
NAM “CBACORPORATIONLTD"  System Sting
POSTADDI *115 Wicks Road" System String =

Formatted | XML

Service invocation completed.

UNISYS |

Securing Your
Tomorrows®

file ool Help

=+ 7] My Service Projects Sendsamplemop_CUST | SendGetCustomer
-] htp/localhost: 24140/ Service sve
5" SenviceContract (WSHitpBinding_Servi || Request
=4 Connect()
-8 Discoriid) Name Value Type
- SendMessage() Name xvz System.Sting
- Send_Selectlspec(
- Sendconnect_Basic)
- SendCustomerAndProduct)
- SendGetAlCientResponse(
“ SendGetAlCierts])
- SendGetCustomer)
-4 SendGe(CustomerAndProduct()
- SendGetProduct(}
& SendGetProductSales)
- SendProductDetails{
“§ SendProductSales))
& Sendsamplemep_CASH(
- Sendsamplemap_CINQQ
-4 Sendsamplemap_CNOTEQ S [7] Start & new proxy
- Sendsamplemep_CUST()
- Sendsamplemep_DOX() Name: Value Type
=8 Sechiarigian, U a SAMPLEMCPDS Client samplemor +
- Sendsamplemep_MENU( e Feree
=8 Seninryenicy NINGO ACTMTH 1208 Systemnt32
: g?::xg:—;gg?g CREDLIMIT 125 System 32 3
o8 S i DD CUSTIMAGE "@\idail\\images\ XYZbmp@D! System. Sting L
-4 Sendsamplemcp_SALE(Q CUSTOMER System. String
-4 Sendsamplemep_SERCH() CUST TYPE System String
& Sendsamplemep_SINGQ DELADD1 System.String
@ Sendsamplemep_SREP() DELADD2 System String
= Sendsamplemcp_WEND{} DELADD3 System.String
% Sendsamplemcp_VPROD( MAINT System.String
Config Fle MessageList_ System.String
NAM "CBACORPORATION LTD"  System Sting
POSTADD1 “115 Wicks Road" System.String -
F| n 3 Formatted | XML

Service invocation completed.

© 2020 Unisys Corporation. All rights reserved.
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Sample M

icroservice

20 SAMPLEICR - Wicrosoft Vil tucic e e |- 2|

File Edit View Project Build Debug Team Data Tools Architecture Test Analyze Window Help

UNISYS |

Securing Your
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L/l Toolbox MR Object Browser GetCustomer.eprec Orchestration.eporch > eiCLl H#eS Web,config IService.cs Referencecs X | = Solution Explorer
5l © Declarations B g% Orchestretion: SAMPLENCFDS 2@
: 4 Basic Activities e ‘-? Deda@tmns o (27 SampleWorkFlow e
£ Pointer (=3 Bxception Handers > (5 UnisysEPortal. DataProvider
g Assign B OOt S ot (5 Unisys EPortal, Edensions
5. %, On Client Session End L Dk ’
AssignMessage o (& On Cient connect_Basic (] Unisys.EPartal Interface
Throw £ [E4 On Client GetAlClierts {F Unisys EPortal JSON
Catch £ (& On Client GetCustomer @] Unisys.EPortal SampleClient i
@ [ Declaations (& Unisys.EPortal SampleDataProvider
4 Structured Activities - [ Bxception Harders B, WcrRestSampleService
Rk Pointer g O Sat 4 & WefRestService3
Mo [% Invoke: Server samplemep_CUST / Orch. Message Bt Properisc
& omee 3 Serversamplemcp_CUST = Orch Message i
3 Reply: Client samplemcp_CUST ol References:
£t WhileDo i & On Clent GetProduct App_Cede
£} Dowhile 4~ [Ef On Ciient GetCustomenAndProduct [ App_Data
By Pikmesssas ] Global.asax
§ ) Servicesve
L Ehessage |3 Web.config B
% 1sOther
4 Communication Activities
R Pointer
2 Connect
% Disconnect
#  InvokeServer 2
o “RecefeeSerer Always Start When Debugg True
4 SendServer a
B OnClientRequest Project File WefRestService3.csproj
El  ReplyToClient Project Folder CA\E-Portal\EAESample!
Ei > 1 X
4 General
@ 0Ermors | 1\ 0Wamings | (i) 0 Messages
There are no usable controls in this group. Description File L. Columin | Project
Drag an item onto this text to add it to the
toolbox.
Development Server
IR B Output B Find Results 1

@ Install Web Components

-Q-ng,j“,? E ST oe

EEIE

S BEa

_ i Publish: | Create Publish Settings =| 4% & -

Prompt for Device —

EOlEL

© 2020 Unisys Corporation. All rights reserved.
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Sample Microservice

-|| % |EPortalinterface

JEF R BE0-

2 |-- Prompt for Device -—

g i Declarati -
L " Declarations Use the grid below to assign @ value tafor each field being sert ta the host. Values may come from variables you declared, fields of messages you 5|
@ 4 Basic Activities declared. orfued values. You may also assign the result of 2 calculation 2s a value: EWarkFlow =
g Boipter EPortal DataProvider
& Assign Field Assigns EPortal.Extensions
AssignMessage EPortalInterface
Thow s lemep_CUST  Assian Fr Data Vah 7 O o
i erver samplemap_| sign From 5 Valus L - e
— POSTADD1 None = EPortal.SampleDataProvider
4 Structured Activities
| CUSTOMER Variable ~ | Cliert GetCustomer. Name [] | | ptsamelesenice
K Pointer | Lis.
enviced
sow POSTADD2 MNone - peitis:
& Ese NAM None - erences £
£1 WhileDo POSTADD3 None. - P Cote
£ DoWhile - Datn
CREDLIMIT Hone - A
= PickMessage i
2 CUST_TYPE Mone - £ hice.sve
[3 IsMessage ks =
2 BOther DELADDA None - e e o i
4 Communication Activities DELADD2 Nore - & oliion Egpores
Rk Pointer DELADD2 Hone -
2 Connect SALESREP s = 'le3 Project Properties -
B [Dmcainecd MAINT Litersl IN =
[2 InvokeServer il e - e
& ReceiveServer It When Debugg True
[  sendServer
B OnClientRequest | WefRestService3.csproj
& ReplyToClient er CA\E-PortahEAESample\WefRestd
4 General
@ 0Ermors | 1\ 0Wamings | (i) 0 Messages
There are no usable contrals in this group. Description File L. Columin | Project
Drag an item onto this text to add it to the
taolbox.
Development Server

% Error List [T

L] .
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Sample M

icroservice

20 SAMPLEICR - Wicrosoft Vil tucic e e |- 2|

File Edit View Project Build Debug Team Data Tools Architecture Test Analyze Window Help

UNISYS |
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L/l Toolbox MR Object Browser GetCustomer.eprec Orchestration.eporch > eiCLl H#eS Web,config IService.cs Referencecs X | = Solution Explorer
5l © Declarations B g% Orchestretion: SAMPLENCFDS 2@
: 4 Basic Activities e ‘-? Deda@tmns o (27 SampleWorkFlow e
£ Pointer (=3 Bxception Handers > (5 UnisysEPortal. DataProvider
g Assign B OOt S ot (5 Unisys EPortal, Edensions
5. %, On Client Session End L Dk ’
AssignMessage o (& On Cient connect_Basic (] Unisys.EPartal Interface
Throw £ [E4 On Client GetAlClierts {F Unisys EPortal JSON
Catch £ (& On Client GetCustomer @] Unisys.EPortal SampleClient i
@ [ Declaations (& Unisys.EPortal SampleDataProvider
4 Structured Activities - [ Bxception Harders B, WcrRestSampleService
Rk Pointer g O Sat 4 & WefRestService3
Mo [% Invoke: Server samplemep_CUST / Orch. Message Bt Properisc
& omee 3 Serversamplemcp_CUST = Orch Message i
3 Reply: Client samplemcp_CUST ol References:
£t WhileDo i & On Clent GetProduct App_Cede
£} Dowhile 4~ [Ef On Ciient GetCustomenAndProduct [ App_Data
By Pikmesssas ] Global.asax
§ ) Servicesve
L Ehessage |3 Web.config B
% 1sOther
4 Communication Activities
R Pointer
2 Connect
% Disconnect
#  InvokeServer 2
o “RecefeeSerer Always Start When Debugg True
4 SendServer a
B OnClientRequest Project File WefRestService3.csproj
El  ReplyToClient Project Folder CA\E-Portal\EAESample!
Ei > 1 X
4 General
@ 0Ermors | 1\ 0Wamings | (i) 0 Messages
There are no usable controls in this group. Description File L. Columin | Project
Drag an item onto this text to add it to the
toolbox.
Development Server
IR B Output B Find Results 1

@ Install Web Components

-Q-ng,j“,? E ST oe

EEIE

S BEa

_ i Publish: | Create Publish Settings =| 4% & -

Prompt for Device —

EOlEL
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Sample M

icroservice

20 SAMPLEICR - Wicrosoft Vil tucic e e |- 2|

File Edit View Project Build Debug Team Data Tools Architecture Test Analyze Window Help

UNISYS |
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L/l Toolbox MR Object Browser GetCustomer.eprec Orchestration.eporch > eiCLl H#eS Web,config IService.cs Referencecs X | = Solution Explorer
gl | b Dechardtions E gk Orchestration: SAMPLEMCFDS e )
: 4 Basic Activities e ‘-? Deda@tmns o (27 SampleWorkFlow e
£ Pointer (=3 Bxception Handers > (5 UnisysEPortal. DataProvider
o Assign i I O Glonl S it A Unisys EPortal Extensions
5. %, On Client Session End L Dk ’
AssignMessage o (& On Cient connect_Basic (] Unisys.EPartal Interface
Throw £ [E4 On Client GetAlClierts {F Unisys EPortal JSON
Catch £ (& On Client GetCustomer @] Unisys.EPortal SampleClient i
@ [ Declaations (& Unisys.EPortal SampleDataProvider
4 Structured Activities - [ Bxception Harders B, WcrRestSampleService
Rk Pointer g O Sat 4 & WefRestService3
Mo [% Invoke: Server samplemep_CUST / Orch. Message — Bt Properisc
& omee 3 Serversamplemcp_CUST = Orch Message i
3 Reply: Client samplemcp_CUST ol References:
£t WhileDo i & On Clent GetProduct App_Cede
£ Dowhile 4~ [Ef On Ciient GetCustomenAndProduct (5 App_Data
By Pikmesssas ] Global.asax
§ ) Servicesve
L Ehessage |3 Web.config B
% 1sOther
4 Communication Activities
R Pointer
2 Connect
% Disconnect
#  InvokeServer 2
o “RecefeeSerer Always Start When Debugg True
4 SendServer a
B OnClientRequest Project File WefRestService3.csproj
El  ReplyToClient Project Folder CAE-Portal\EAESamplel
Ei > 1 X
4 General
@ 0Ermors | 1\ 0Wamings | (i) 0 Messages
There are no usable controls in this group. Description File L. Columin | Project
Drag an item onto this text to add it to the
toolbox.
Development Server
IR B Output B Find Results 1

@ Install Web Components

-Q-ng,j“,? E ST oe

EEIE

S BEa

_ i Publish: | Create Publish Settings =| 4% & -

Prompt for Device —

EOlEL
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Looping Ispec Workflow

B G On Clent GetAlClierts
B [ Declarations

* Derive data from one or more Ispecs . Gl Vaiables
] . Iﬂ |7 Server Messages
° Create services using data from L[] samplemco_SERCH
. (- | Client Messages
mUItlple ISpeCS - [ GetAlCiertResponse
] . w0 GetAlClients
* Point and Click development [ Brcegtion Handers
B O Sat

- | & Invoke: Server.samplemcp_SERCH / Orch Messags
- 123 Serversamplemcp SERCH = Orch Message
- " Client GetAlClient Response. DETAILS = Server samplemcp_SERCH.DETAILS
=~ {;} Do While {Server samplemcp SERCH.STARTNAME =)
----- f Invoke; Server samplemcp_SERCH / Orch Message
----- 53 Server samplemcp_SERCH = Orch.Message
- " Cliert GetAlChent Response. DETAILS += Server samplemep_SERCH.DETAILS
gl Reply: Client GetAlClient Response
= g.j (On Client. GetCustomer

© 2020 Unisys Corporation. All rights reserved.
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ePortal Architecture

ePortal Data Source

Smart MVC WCF WebAPI
_ _ Custom . :
Clients J Graphical Services | Services

Consumers Consumers Consumers Consumers

L] N
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ePortal Architecture

Smart
Clients

Consumers

° A
UNISYS | fromens”

ePortal Data Source

MVC
Graphical

Consumers

Custom

Consumers

WCF
Services

Consumers

WebAPI
Services

Consumers

>
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Swagger Documentation

pet Everything about your Pets

Find out more ™

l POST /pet/{petld}/upleoadImage uploads animage

[ /pet Adda new pet to the store

‘ /pet Update an existing pet

[ J/pet/findByStatus Finds Pets by status

b
W
]
]

fpet/findByTags Finds Pets by tags

B

lﬂ Jpet/{petId} FindpetbylID

l /pet/{petId} Updates a petin the store with form data

I /ret/tpetey Dotesape

. )
UNISYS | Snamsne”
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Sample ePortal MVC System

| - http://localhost:58331/5chaolSysDataSource/schoolsys_STU pL-c

| Students

‘ePortaJ' Academy

Student Details Documents Other Data

School System

Student Registration

T
A

Add Delete Inquire

21:33:48:19 INPUT REQUEST

®
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Student 1 Details

|- hitp://localhosk:58331/5choolSysDataSource/schools

|- hitp://localhosk:58331/5choolSysDataSource/schools

| schoolsys [Nigel Tunnicliffe] * | | schoolsys [Nigel Tunnicliffe] *

‘ePortaI Academy ‘ ‘ePortaI Academy :
Studenti doc Other Data Student Details Other Data
C# Programming Syllabus

[Semester and Year]

School System

Instructor Information

Student Regist'aiion Instructor Email Office Location & Hours
Fred Smith [Email address] [Location, Hours, Days]

General Information

Description
To replace any placeholder text (such as [Course Hame] above), just click it and type.

Expectations and Goals

You might love the look of this clean, professional syllabus as much as we do. But it@s also easy to get exactly the look you want. On the Design tab of
the ribbon, check out the Themes, Calors, and Fonts galleries to preview options right in your document and then click to apply one you like.

Course Materials

Required Materials

Meed a heading or a bullet? On the Home tab, in the Styles gallery, choose from all styles used in this syllabus.
* Click here to add text.

17:07:25:96 INQUIRY REQUEST * Click here to add text.

Add Delete Inquire

Optional Materials
Want to add more tables to your document that look like the Course Schedule and Exam Schedule tables that follow? Mothing could be easier. On the

°
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Student 2 Details

J|1= hitp://localhost:58331/SchoolSysDataSource/schools

| schoolsys [Gary Taylor] X

‘ePortaI Academy

Student Detai Student? doc Other Data

School System

Student Registration

P
fGory Taylor
I 21

Add Delete Inquire

17:08:51:29 INQUIRY REQUEST

- O
)| 1= hitp://localhost:58331/5choolSysDataSource/schoals o~ C—V 3t
| schﬂ;I;yS[GaryTaylnr] X
‘ePortaI Academy

Student Details Student2 doc. Other Data

Agile Business Suite Programming Syllabus

[Semester and Year]

Instructor Information

Instructor Email Dffice Location & Hours
Gary Taylor [Email address] [Location, Hours, Days]

General Information

Description

To replace any placeholder text (such as [Course Hame] above), just click it and type.
Expectations and Goals

You might love the look of this clean, professional syllabus as much as we do. But it@s also easy to get exactly the look you want. On the Design tab of
the ribbon, check out the Themes, Calors, and Fonts galleries to preview options right in your document and then click to apply one you like.

Course Materials

Required Materials

Meed a heading or a bullet? On the Home tab, in the Styles gallery, choose from all styles used in this syllabus.

* Click here to add text.

* Click here to add text.

Optional Materials

Want to add more tables to your document that look like the Course Schedule and Exam Schedule tables that follow? Mothing could be easier. On the

L] .
UNISYS | 5romea”
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ePortal MVC Application

| - http://localhost:38331/5choolSysDataSource/schoalsys. !

sTU R~
| schoolsys [Nigel Tunnicliffe] * <\
ePortal Academy \
Student Details Studentt doc
DUNS Number Organizatid Address Town
1234567890 Studio Staalkaart E M Beimastrjitte 56-58 :
Map Satellite <
(=] \
=
oo
&

& stichting K cq
- CA Burgerkgp

Her . foF

et Hog

T

[ ]
UNISYS | 5romea”

MVC Application

Data generated by call to
external web service from
Web server

Data generated from
Browser

Ispec data generated
from Agile Business
Suite application

© 2020 Unisys Corporation. All rights reserved.
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inForm Interface

LE) — x
Eile View Window Debug Help

Go'to lspec |

“J/ SchoolSys on LocalHost + x | Studentldocx R x

C# Programming Syllabus

[Semester and Year]

School System

Instructor Email Office Location & Hours
Fred Smith [Email address] [Location, Hours, Days]

General Information

Student Registration Desciption

To replace any placeholder text (such as [Course Name] above), just click it
and type.

Expectations and Goals

You might love the look of this clean, professional syllabus as much as we do.
But it's also easy to get exactly the look you want. On the Design tab of the

ribbon, check out the Themes, Colors, and Fonts galleries to preview optiens
right in your document and then click to apply one you like.

Nigel Tunnicliffe

Course Materials

Required Materials

Need a heading or a bullet? On the Home tab, in the Styles gallery, choose
from all styles used in this syllabus.

*Click here to add text. v
SchoolSys on LocalHost. nx
Name Value

_TOP_LINE_ STU TOO0G0217APR17

_ACTMTH 1704

_UserMAINT  INQ

STUDENT 1

NAM Nigel Tunriclffe

Age 021

Add Delete Documents

°
UNISYS } e ox © 2017 Unisys Corporation. All rights reserved.
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Leverage Agile Business Suite application

Invoke Agile Business Suite method Expose method as a ‘Public Segment
from .Net application Method’ and invoke via Client Tools
E.g. Validate Account Number Less overhead than the Ispec cycle

Built into ePortal 11.0 and above

Use Application Integration Services
(AIS)

°
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Single Sign On (SSO)

Problem statement:
Clients did not want to log on to workstation and Application
Current implementation also required Host level User ID and Password management
For Auditing Application had to be able to Identify end user
Application runs on Windows and MCP — Client is ASP.Net solution

Solution SSO
But

Both Windows and MCP Clients complicated things
Could not assume Windows Active Directory available end to end
No COTS based SSO solution for AB Suite

°
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SSO Approach

* First Understand what SSO really means
= In one word Trust

° Its about trusting that the session is initiated by
someone you trust and so you can trust the
information they supply

° SOIUtlon Public/Private Key

= Active Directory (AD) for
Workstation/\WebServer trust

= Public/Private Key Certificate
for WebServer/Host trust

°
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AB Suite Solution

Both Windows and MCP support Public/Private key encryption Public/Private Key

Build ALGOL and .Net external Libraries to handle Certificates |=_O
Create AB Suite Methods to call external routines .l

Use AD Trust to Web Server
Allows Web Server to use/trust workstation Logon details

Use Trusted Certificate to provide Trust between Webserver and AB Suite Host
Pass Logon details as encrypted message to AB Suite Host Application
Using Certificate to Encrypt/Decrypt
Performed as handshake at session establishment via Hidden ISPEC not shown to end users
Works with standard RATL no need to change anything at AB Suite Product Level

Uses Certificate to encrypt generated AES256 key used to encrypt message text
Overcomes message length limitations
Allows for other encryption uses

°
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Message flow

Shared Certificate

(Including Private .
Key) Client

Call Encryption Library to

Establish session

decrypt initial handshake
message using Certificate
private Key

Extracted
AES256 Key

Respond with message containing AES256 key
encrypted using Certificate Public Key

Respond with message encrypted using
extracted AES256 key

Call Encryption Library to
encrypt using Saved AES256
key

L3

Optionally - Any further secure communication to
host for this session will use only extracted AES256
key

Call Encryption Library to
encrypt/decrypt using Saved
AES256 key

° A
UNISYS | fromens”

<

Shared Certificate
(no Private Key)

Call Encryption Library to

encrypt initial handshake

message using Certificate
public Key

Call Encryption Library to
decrypt using Saved AES256
key

Call Encryption Library to
decrypt/encrypt using Saved
AES256 key
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Create Modern User Interface

Create a modern web based interface Use ePortal to create a Microsoft
but without re-writing Agile Business WeDbAPI solution
Suite application Core interface generated automatically

Additional features added manually
Interfaces with external system

Use Orchestration to create composite
screens

One-to-Many

Many-to-One

°
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Common Gateway

* Common gateway to wide variety of
back end systems
= Agile Business Suite application
Oracle Application
SharePoint
Content Management
Third party applications

* Common infrastructure

* Common look and feel for all
applications

[ ]
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Available On-Line Services

2% online services
L3 QG

Planning Applicati

Searct
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Common Gateway

* Common gateway to wide variety of
back end systems
= Agile Business Suite application
Oracle Application
SharePoint
Content Management
Third party applications

* Common infrastructure

* Common look and feel for all
applications

[ ]
UNISYS | 5romea”

Available On-Line Services

2% _ online services
N

Planning Applicati

Searct
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Model based Interface

* Custom solution to map .Net Classes

to an

<Iap

Publ

1
R

1
End -

<I=p
Publ

Ispec

eclame ("CUST"), -DataContracti)>-_1
ic-Class -Customerq

Clas= -definition> -4

Propertyf

echDataltem ("CUSTHAM") , -DataMember|)>- 9
ic -Property -Name () -As -S5tringd
-Getq

- - -Return - Nameq

-End -Getq

-Set (ByVal -value -A=s -5tring) g

- - _Hame -=-valued

-End -5etq

Property"

End -

[ ]
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| Address 2

| Location X

() INotifyPropertyChanged
_r - - @

Class

=l Fields
g _Linel
4 _Line2
=l Properties
= Line1
= unez
= Methods
W New (+ 1 overloa...
2"¥ Propertyvaluech...
= Events
#  PropertyChanged

Enum

Local
Europe
RestOfTheWorld

' Address

Customer
Class

=l Fields
47 _Address
¥ _Age
4* _DateOfBirth
4* _Location
47 _Name
4 _Sales

= Properties
2 Age
7 DateofBirth
' Name

j‘ Location

' Sales

() INotifyPropertyChanged
{ pataBoundciass 2 |
! Mustinherit Class i

| = Methods

+¥ Propertyvaluech... |

| = Events

¥ PropertyChanged

N i v,

Sale 2
Class
-+ DataBoundClass

= Felds
&4¥ _Desaiption
4¥ _ProductNo
= Properties
' Description
=7 Productio
= Methods
9 New
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Isle of Man

On-Line Tax Return

sle of Man Publi

Services

icrosoft Internet Explorer =]

Fle Edt Visw Favortss Tooks  Help |
Qeack - ) - = 2 D search avortes ) | (- LS E
tetdress [] hrep TaskomTaskT ype—IoM e laCradad = B ‘Linl@ »| & snaglt |25

£\ myGov.im

online services+  Logged in as Pastie User 20 / Logoff

HOME AGCCESSIBILITY SEARCH NEWS CONTASTS PRIVACY

HOME RESIDENTS BUSINESS YISITORS GOYERNMENT ISLE OF MAN INFOCENTRE ONLINE SERYICES
[ ] IEEI DY) J J ] .y

‘You are here: www.gov.im - Online Services - Income Tax - Individual Tax Services - Return Details - Edit Task

ONLINE HELP

Account: Pastie User 20

services

MY ACCOUNT

Administration
Messages (330)
(331)

Logaff

INDIVIDUAL TAX
SERVICES

Personal Details
Function Menu
Return Details

Assessments and
Charges Details

Payments

Online Services Home

DisabledGo Information

Name & tax reference: MR RES RES (H341194-63)
Return period: & April 2009 to S April 2010 (Due date: & October 2010}

ISLE OF MAN - BANK/BUILDING SOCIETY INTEREST

Bank and building society interest includes any interest received on accounts and products held or taken out with the Isle of Man branch of local and international banks and building societies, UK and
overseas accounts and products, for example National Savings, should not be declarsd here but should be declared in the appropriate overseas income section

You should nate that all interest must be declared; there are no minimum limits or exemptions for small amounts

The table below shows a summary of accounts entered. If the account description is correct, you can use the "Gross Amount” box to enter the amounts of interest received in this period then press "Save
as Complete’ when you are finished.

# To ADD an account, please click the "Add Account” button below,

b To EDIT an entry, use the "Edit’ button against the relewant entry to amend the account details or, if the income erded during the period of this return, to mark the account as closed

Mzgs Bank 12345678 1000.00 ¥ provisional?
Even Bigger Bank 10 I pravisianal?

D ACCOUNT

If you need to add any supporting documentation, please select "Attachments* from the Task List once you have saved this screen

| SAVE AS COMPLETE

Terms & Conditions ©2010 Crawn Capyright

|

] il

(&) [& Local ntranet
Aistart| (G & 6B > O Taxadapters submission. . | ¥4 Source Control Explorer .. | 3 Chang= Request 3730 - . | £ Indiidvl T Reburns - .. | €] ttachments - sk of M. . [ Tele of Man - Bank/Bu...

e

[ ]
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Microsoft ‘Office’ interface

Create pro-forma letters from template
User selects appropriate account
Selects letter required from drop down list

Letter contains a macro which uses Client Tools to extract name and address from Agile
Business Suite application

Letter saved to document management system
E-Mail sent to user informing them of the new letter
Agile Business Suite application updated with a refence to the letter

Benefits
Cost saving (no printing or postage)
Agile Business Suite application user has a copy of the same letter sent to the end user

°
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IBM WebSphere Interface
(Outbound)

* Agile Business Suite Application
creates letter request
= Request written to IBM MQ Queue

= Letter created by third party document
management system

= Response written to queue

= Agile Business Suite application
updated via Client Tools

[ ]
UNISYS | 5romea”

Clear Path MCP Queuing
ﬁ f
T e
i = — Documen t
AB SUItE % e Creation
Application % -
& )
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IBM WebSphere Interface
(Inbound)

Variety of channels to Agile Business
Suite application

Web Pages

External systems

‘Batch’

Custom .Net Service to read from MQ
Queue and send to Agile Business
Suite application

Uses ‘COMManager’ Interface

Full access to Ispecs with a user interface
Also NOF and XML interfaces

UNISYS | fecrg o

WebSphere
Message
Queuing

[g
K

]
Enterprise ~ " e=a--Ed z
Service — = AB Suite
Bus e 3 Application
i}
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XML processing in Agile Business Suite on Windows

1. Source of input xml messages
message

2. Client submits

Runtime system

3. Runtime executes
transaction

ﬂm

\

Client Program

= ———

5. Optional response
message to external
system

4. Runtime responds
to client

L] .
UNISYS | #romsa”

Parse Message

Validate content

Method Logic

- Receive()
- Respond()

Prepare response
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Create something completely different

Problem Business Solution
* None of the previous options fits your * Create a custom generator
needs = Generate your custom interface as part
of the build

= Samples and documentation included
with customization kit
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@ Altova XMLSpy - [CUSTxsd *]

@ File Edit Project XML DTD/Schema Schemadesign XSL/XQuery Authentic DB Convert View Browser Tools Window Help

= X
- @x
DEREHB S 1 BE - HhER DD B Y BBH B0 R o MG
| :‘%J Components X%
E element (1)
complexType (1)
—d @ simpleType (45)
=
Cust Type
) <xs:element name="_UserMAINT">
<xs:annotation=
1 i <xs:documentation=_UserMAINT String [3]</xs:documentation=
<fxs:annotation=
<xs:simpleType=
<xs:restriction base="xs:string">
! <xs:enumeration value="ADD"/>
<xs:enumeration value="CHG"/>
<XSIBI"ILII'I"IBI'Et!DI"I value= PUFE 1> ‘ Globals | Namespaces | Identity constraints
<xs:enumeration value="INQ"/> —
<xs enumeration value="FIR"/> Rt i
<xs enumeration value="BAC"/=| name | UserMAINT ~l
<xs:enumeration value="NEX"/> sRet [
i <xsienumeration value="LAS"/> widec 11
</xsrestriction> i
o G type  xsstring =
<fxssimpleType content simple &
<fxs element= derivediy restriction ]
default -]
fixed >
niliabie -
hlnek - i
Details ‘ SimpleType
Facets nox

| | Authertic | Browssr

Messages

{ gﬂ BiBlE s 5] X

Fila £-INREN _CFVClascacicaminnisrele amnlabinenathiawelCl 19T ved ie valid

|Messagas \ XPath/%Cuery | XSL Outfine | Findin Files | Find in Schemas | Find in XBRL | Charts

XMLSpy Professional Edition v2016 rel. 2 sp1  Registered to NIGEL TUNNICLIFFE (UNISYS CORPORATION) ©1998-2016 Altova GmbH

Facets | Patterns | Enumerations | Samples
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@ Altova XMLSpy - [CUSTxsd *]

@ Ele Edit Emjed XML DTD/Schema Schemadesign XSL/XQuery Authentic DB Convert Wiew Browser Tools Window Help

walolg|f

o |

HAM

NAM S

FcusT_TypE

Customer Type

[FcrREDLIMIT

" _UserMAINT": {
"description™:

™Tminlength™:
"maxT.ength™: 3,
Tenum™: [

"ADD"™,

"CHG™ ,

"pUR™,

"INg©,

"FIR™,

"BAC™ ,

THEX,

nLAS®

L {TAction_Line_ACTION_LINE_ACTI...
ACTION 1

Ted | Gid || Schema | Authertic Browser

"_UserMAINT String [3]",

TtvpeY i Metring”;

Messages

|( NI

M Fila £-INREN _CFVClascacicamiinisyrele amnlabinenatwiawelCl ST ved ie valid

— X
- 8%
Components nx
element (1)
complexType {1)

@ simpleType (45)

‘ Globals | Namespaces | |dentity constraints

Details o x
name | UserMAINT -~
isRet ]

minOce {1

maxOce

type Ixs:string -
content |simple -
derivedBy restriction -
default |
fixed >
niliabie ok
bk il
Details ‘ SimpleType
Facets nox
INQ
FIR
BAC
NEX
LAS

|Messagas \ XPath/XQuery | XSL Outfine | Find in Files | Find in Schemas | Find in XBRL | Charts

XMLSpy Professional Edition v2016 rel. 2 sp1  Registered to NIGEL TUNNICLIFFE (UNISYS CORPORATION) ©1998-2016 Altova GmbH

Facets | Patterns | Enumerations | Samples
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Conclusions

Agile Business Suite applications can interoperate with other applications on other
platforms
Many different ways of implementing the solution

Come and talk to us about your requirements

°
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Thank You




